
ANIMACIÓN
TOON BOOM



¿Qué es 
Toon Boom Harmony?
Toon Boom Harmony es el estándar mundial para
producciones de animación 2D - un software que

permite a los profesionales crear animaciones cut-
out o animación frame by frame con sus múltiples

funcionalidades y herramientas.

Series y películas como “Padre de Familia”, “Los
Simpsons”, “La princesa y el Sapo”, ”Kim Possible”, “Bob

Esponja: la película” (entre muchos otros) fueron
hechos con este software de animación.



La animación Tradigital
Se refiere a la fusión o combinación de los métodos

tradicionales e informáticos (digitales), la mezcla entre
técnicas de animación bidimensional (2D) y tridimensional
(3D) - Este formato consiste principalmente en trabajar el
dibujo cuadro a cuadro directamente en un software de
animación, sustituyendo todo tipo de material físico como

los lápices y las hojas de papel.

Por ejemplo - Klaus (2019) es un largometraje animado de
Netflix donde todos los frames han sido ilustrados usando
Toon Boom Harmony, donde los animadores dibujaron a
mano con tabletas gráficas en el software.

https://www.youtube.com/watch?v=BlU49dJhfcw

https://youtu.be/BlU49dJhfcw?si=PVy9OFlL_UD4mrB5


Ten en cuenta que... 
Cuando se crea un archivo de Toon Boom nos
crea una carpeta con más archivos y carpetas
adentro. De ahí...

Para abrir un proyecto se selecciona el archivo
que tenga EL LOGO DEL PROGRAMA.

No va a funcionar si le hace falta alguna de
las otras carpetas o archivos con las que se
crearon a su vez.

Se recomienda crear una carpeta previa y
que ahí se guarden todas las otras carpetas
y archivos del proyecto.

Creando un archivo nuevo



Creando un archivo nuevo

Crea la carpeta para todo el proyecto.1.
Selecciona guardar el proyecto en dicha
carpeta. (Examinar > Seleccionar carpeta...)

2.

Dale un nombre a tu proyecto
(Recomendable pensar en el nombre,
enumerarlo, etc.)

3.

Selecciona el Tamaño de cámara4.
La que normalmente se usa es el
HDTV_1080p24 = 1920 x 1080, 24 fps
(Tamaño de una pantalla normal y donde
correrá mejor).

a.

Selecciona el botón Crear escena.5.



La interfaz de trabajo



En la línea del tiempo verás tus frames de la animación,
encontrarás también la vista de “Librería de Nodos”

Justo por encima de la línea del tiempo encontrarás
otras herramientas para la visualización del
proyecto, como la mesa de luz, máscara de cámara,
vista en render, etc.
También muestra: efectos, sonidos, duración de
escena, fotogramas clave, tiempo y fotogramas
generales.

LÍNEA DE TIEMPO



¡Veamos a

detalle!



¡Veamos a

detalle!



En el momento en que tu realices algun trazo
en el área de trabajo (vista de cámara), en tu
línea del tiempo se va rellenar el frame que
tengas seleccionado para reflejar la existencia
de contenido en dicho frame.
Pero recuerda - para poder realizar una
animación es necesario la aplicación de los
Keyframes, pues si no los aplicas, cualquier
cambio que hagas a un frame se le va a aplicar a
los demás.

Aplicar keyframes: seleccionando un frame
> click derecho > Insertar fotograma clave
(F6), insertar fotograma clave y duplicar
dibujo...
Los Keyframes serán reconocidos por un
cuadro negro sobre un frame. 

LÍNEA DE TIEMPO
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BARRA DE HERRAMIENTAS
Seleccionar1.

Editor de contornos2.

Pincel3.

Lápiz 4.

Sello5.

Borrador6.

Texto7.

Rectángulo8.

Pintar9.

10.Cuentagotas de color

11.Pivote de dibujo

12.Morphing

13.Mano

14.Animar fotograma actual

15.Transformar

16.Cinemática inversa

17.Mostrar papel cebolla

*Recuerda checar las flechas grises para
encontrar más herramientas



Propiedades
 de herramienta + paneles

de trabajo
Cada vez que seleccionemos una de las herramientas de
nuestra barra de herramientas, se nos mostrará al lado
derecho las propiedades de herramientas en un panel
bajo el mismo nombre, donde podemos modificar las
características o forma de trabajo de dicha herramientas
(algunas no tienen propiedades por cambiar)

Podemos añadir más paneles/vistas como el de
color, librería, entre otros cuando seleccionamos el
botón de (+) qué está en la esquina superior
derecha.
Para cerrar un panel seleccionamos el botón (x)
qué está en la esquina superior derecha.



LAS CAPAS
Al lado izquierdo de la línea del tiempo nos
encontramos con el apartado donde se encuentran
las capas que le agreguemos a nuestro proyecto.

Para agregar capas selecciona el botón (+) y
después hay que seleccionar que tipo de capa
quisieras agregar y darle un nombre.
Para eliminar capas selecciona el botón (-).
La Carta de color es importante, pone un fondo
a nuestra animación para que si se vea a la hora
de renderear.

Y no solamente cuando hablamos de capas nos
referimos a las que aparecen a un lado de la línea del
tiempo, también nos referimos a las capas de línea
y color. Estás capas simplemente nos ayudan a
mantener un orden y separación entre nuestros
elementos, por si nos vemos en la necesidad de
modificar las líneas, no afectemos el color. Pero no
hay problema si decides no utilizarlas.



ORGANIZACIÓN
DE LAS CAPAS

Recomendamos tener la CARTA DE COLOR hasta
abajo.
Cuando seleccionas una capa y la jalas hacía otra
capa, está automáticamente se va a convertir en
una “capa hija”, representado con una línea (que
tiene forma de L) y echado más al lado derecho.

Si mueves a la capa padre con la herramienta
de Transformar, la capa hija le va a seguir.
Puedes romper el vínculo de capa padre-hija
si a la capa hija la vuelves a jalar por encima
de la “capa padre”.
Si visualizas una línea de color cian, la capa
que arrastres y sueltes NO se convertirá en
una “capa hija”.

Recuerda que las capas que vayan arriba de
otras, van a ocultar los elementos de las capas
que vayan por debajo.



En la pestaña de color nos encontramos con la
paleta de color de nuestro proyecto - puedes
crear nuevos colores al seleccionarel botón (+).
Si se ha usado un color para varios elementos, y
se cambia dicho color, todos los elementos que
tengan dicho color anterior también se van a
cambiar al nuevo - sin importar la cantidad o si
están en frames diferentes. 

Paleta de color y colores

Papel cebolla
En la barra de herramientas encontrarás la
herramienta papel cebolla, mostrará los dibujos
anteriores y siguientes para usar de referencia.

Color rojo significa “frame anterior” o “antes”.
Color verde significa “siguiente frame” o
“después”.



¡Veamos a

detalle!



El panel Drawing Substitutions (Sustituciones
de dibujo) de la vista de librería permite cambiar
rápidamente la exposición del fotograma
actual a uno de los dibujos existentes en una
capa. Esto es útil para animación de bocas,
manos, párpados y otras partes del cuerpo de un
personaje cut-out, que suelen contener
variaciones e intercambios.

La vista de sustituciones de dibujo permite ver
todos los dibujos de la capa seleccionada en una
lista de imágenes en miniatura, así como seleccionar
rápidamente qué dibujo se debe exponer en el
fotograma actual. 

Dibujos de
sustitución



Vértices y líneas
vectoriales transparentes

Recuerda: No se pueden rellenar de color ningún
elemento si no está bien cerradas las líneas
vectoriales - para identificar si un elemento se puede
rellenar de color es si tiene todos sus vértices cerrados.

Vértices cerrados = Vertices de color azul / cruzan
con líneas azules.
Vértices abiertos = Vertices amarillos / no cruzan
con ninguna línea azul.

Usa la herramienta Editor de contornos y
arrastra el vértice hasta que se cruce con una
línea. 
Usa la herramienta Línea vectorial
transparente o Cerrar hueco (subherramientas
de la herramienta de pintura).

Para ver las líneas azules / líneas vectoriales
transparentes haz click derecho y activa la opción
“mostrar líneas vectoriales transparentes.” (K)



A un lado de la línea de tiempo está la Librería de
nodos - Aquí podras encontrar los efectos para tus
animaciones, separados en diferentes categorías.

Para agregarlos al proyecto, con click sostenido,
hay que arrastrarlos hacia la vista de nodos,
para después pasar al proceso de conectar
nodos con nodos y que estos se vean reflejados
en la vista de cámara.

LIBRERÍA DE NODOS



En la vista de nodos puedes conectar efectos y
nodos de composición para formar una red -
denominado sistema de nodos.

Útil para crear un rig de marionetas, crear efectos
avanzados y tener una visión clara de escenas
complejas.
La organización y el orden de los nodos
determinan el flujo de datos durante el proceso
de composición y cómo se compondrán los
elementos de animación.
¿No encuentras la barra de herramientas de
los nodos? Ventanas > Barras de herramientas >
Vista de Nodos.

VISTA DE NODOS



Todas las capas deben de estar conectadas al
COMPOSITE (espacio de trabajo). 
El orden importa pues refleja que elemento irá
atrás o adelante en pantalla.

Izquierdo = al frente
Derecho = atrás

Si está en ROJO significa que está OCULTO.
Si está en AZUL CLARO significa que es VISIBLE.
Lo que este desconectado al COMPOSITE, NO SE VA
A VER. 
Para acomodar los nodos en Vista de Nodo: 

Selecciona todos los nodos > Orden de red
descendente
¿NO ESTÁN ESAS HERRAMIENTAS EXTRAS? Clic
derecho a un lado de Home > Vista de nodos

VISTA DE NODOS



Para conectar nodos hay que hacer click en el
cuadro pequeño superior centrado, y con click
sostenido, arrastrar hacia el COMPOSITE.

Para que se apliquen los nodos y su efecto se
tienen que conectar primero las capas (u otros
nodos incluso) al nodo/efecto, después el nodo
se conectará directamente a COMPOSITE. 

Algunos nodos tienen incluido una versión en
invertido, representado con una máscara que al
hacerle doble click se invierten sus colores, lo que
significa que el efecto invertido está activado - el
efecto se aplicará de forma contraría.

VISTA DE NODOS

¡Si estuvierainvertido,esconderíatodo menos loque se hapintado enverde!



CUTTER: Máscara, para cortar partes de una capa o mostrar solo ciertas
partes de una capa habilitando su parámetro Invertido.

GLOW: Brillo, convierte un área luminosa con una luz brillante de
bordes suaves o una región de luz difusa alrededor de una imagen.

SHADOW: Sombra, puede convertir una imagen o área en sombra.

BLENDING: Se puede utilizar para componer un elemento, efecto o
composición utilizando uno de los muchos algoritmos diferentes que
pueden hacer que se vea mucho mejor en el renderizado final.

BLUR GAUSSIAN: Suaviza la imagen, reduciendo la cantidad de ruido y
detalle.

Algunos nodos importantes

¿Quieres ver como te está quedando tu trabajo
con los nodos? Activa la Vista de Render



Un rig de personaje es una plantilla basada en el
modelo del personaje, en la cual todas las partes
móviles están divididas en distintas capas y
ordenadas en una jerarquía que facilita la animación
digital, conocida como animación cut-out. 

Toon Boom Harmony permite crear rigs en una
jerarquía elaborada, permitiendo establecer qué
partes del rig deben influir en otros miembros y
cómo pueden moverse de forma independiente -
unos elementos se convierten en “capas padre” de
otros elementos, que serán las “capas hija”, que
seguirán a la capa padre que estén vinculadas.

Creación de un rig de
un personaje cut-out



Ten en mente al hacer
RIGS en Toon Boom

Cada parte del cuerpo tiene que estar en una
capa diferente (Ej. El brazo en una capa, el
antebrazo en otra capa, la mano en otra capa,
etc.)
Se hacen uso de los nodos Pegs - se utilizan para
almacenar transformaciones geométricas sin
necesidad de modificarlas (posición, escala,
inclinación y ángulo), así como animaciones, y
aplicarlas a dibujos.

El acomodo es en formato de “Escalera”.
Ej. Primero conectas el peg de la mano al peg
del antebrazo, luego al del brazo, y luego al
del torso.

Para mover las cosas solo se tiene que hacer
seleccionado el Peg (verde), nunca el
dibujo/capa (azul claro) - puede provocar cambios
y destruir todo el rig.



Peg maestro

Para mover el pivote hay que hacerlo con las
herramientas de la parte superior. (Se encuentran en el
área de Animación Avanzada)

Animación avanzada: click derecho en la barra de
herramientas superior.

Los rigs se hacen con las herramientas de
Deformación

Deformación: click derecho en la barra de
herramientas superior.
Siempre hay que tener activo la opción de Habilitar
Deformaciones.

Los rigs siempre deben de tener un peg maestro
(pivote) que se conecta a todas sus partes. 

Permite manipular todo el rig desde una única capa,
sin necesidad de manipular cada parte individual.
Seleccionar peg de hasta arriba > Añadir nuevo peg
> renombrar nuevo peg con “MASTER/MAESTRO” >
conectar a los otros pegs.

Ten en mente al hacer
RIGS en Toon Boom



Colocación de pivotes
Las transformaciones realizadas sobre una capa de dibujo
(rotación, escala, sesgo y volteo) se realizan de forma
relativa a la posición del punto de pivote del dibujo.
Mientras tengas seleccionada la herramienta de
Transformación, puedes arrastrar y colocar el pivote de
la selección - pero esto no tiene un efecto permanente,
pues solamente se quedará en el nuevo lugar en el frame
que se encuentre, para luego regresar a su punto original
al pasarse a otro frame.

Para cambiar de posición permanente del punto de
pivote de una capa...

Seleccionar ilustración > Activa la herramienta de
Transformación > Barra de herramientas de
animación avanzada > Activa la herramienta Trasladar
(Alt + 2) > Mueve el punto de pivote al lugar deseado y
selecciona otra herramienta para desactivar la de
Trasladar.

Checa de nuevo con Herramienta de
Transformación para verificar que el punto de
pivote sigue donde lo haz colocado.

Barra de herramientas de
animación avanzada

Punto de pivote



Nos referimos a los movimientos automáticos que hace
el programa de un fotograma clave a otro - esto para
evitar vernos obligados a dibujar frame por frame. Es útil
para animar elementos que no tienen mucha animación,
como: fondos, cambios de cámara, movimientos de cámara.

Se necesita el uso de un peg (actuará como un control).
Capa con ilustración > Ctrl + P (añadir el peg) > señalar
key frame 1 (línea del tiempo, en la capa del peg) >
señalar key frame 2 (línea del tiempo, en la capa del peg) o
realizar directamente el movimiento deseado usando la
herramienta transformar (en el frame seleccionado en la
línea del tiempo).

La herramienta transformar es la única que
puede animar pegs.
Puedes modificar la velocidad de las animaciones con
Definir el tipo de aceleración.
Herramienta transformación > clic a la trayectoría >
tecla P > crea un punto de movimiento para
personalizar la ruta de animación.

Interpolación de
movimiento Definir el tipo

de aceleración

Mostrar control

Punto de
movimiento



Resulta que las cámaras también pueden ser animadas en Toon
Boom Harmony, pues es también una capa y un elemento animable. 
Antes que nada, ¿Cómo añadimos una cámara?

En la vista de línea de tiempo, haz clic en el botón Add Layer
(Agregar capa) del menú emergente y selecciona Camera
(Cámara). 
En el menú superior, selecciona Insert (Insertar) > Camera
(Cámara).

 
Se muestra en la vista de línea de tiempo y puede utilizar las mismas
herramientas y modos de selección para compensarla o animarla -
ojo, la capa de la cámara en sí es estática, lo que significa que
mantiene la misma posición y ángulo en toda la escena.

Para poder animar la cámara, es necesario conectarla a una
capa de peg (Agregar capa > Peg padre), que se puede animar, y
que afectará directamente a la posición y al ángulo de la
cámara.
Puedes agregar fotogramas claves, usar la herramienta de
transformación para mover la cámara (desde el peg) ,etc.

MANEJO DE CÁMARA



Se puede configurar fácilmente un multiplano creando un fondo
sobre varias capas, extendiéndolas en el eje Z para agregar
profundidad y moviendo la cámara por el entorno resultante
para crear una ilusión de perspectiva. impresionante.

Asegúrate de que la opción No Z Dragging (No arrastrar
en Z) del menú superior Animation (Animación) esté
deshabilitada.
En el menú superior, selecciona Animation > Tools >
Maintain Size (Animación > Herramientas > Mantener
tamaño).

Para visualizar el multiplano: Windows > Perspective
(Ventanas > Perspectiva).

Rotar vista: CTRL + Shift + Clic izquierdo sostenido.

¡Y con solo seleccionar y arrastrar puedes mover los
elementos en el eje Z!

EL EJE Z
EL MULTIPLANO



Dentro del apartado de los paneles de trabajo podemos
encontrar uno llamado Coordenadas y puntos de
control. En este panel/vista podemos encontrar todo lo
relacionado a las coordenadas y otros datos específicos
de nuestros elementos (ya sea una capa, una ilustración,
cámara, etc.)

Podremos encontrar los apartados de:
Posición
Escala
Rotación
Sesgar

COORDENADAS



En el menú superior, selecciona File > Import >
Images (Archivo > Importar > Imágenes).
En la sección Files (Archivos) del cuadro de diálogo
Import Images (Importar imágenes), haz clic en
Browse (Examinar) para buscar y seleccionar una o
más imágenes en el ordenador.

La imagen (o imágenes) que agregues se van a convertir
en un mapa de bits (imagen de píxeles) - a la cual vamos a
tener que agregarla a una capa (Create Layer(s) y
seleccionar una de las siguientes opciones: 

Create Single Layer Named (Crear una sola capa con
nombre).
Create Layer(s) Based on Filenames (Crear capas
basadas en nombres de archivo)
Add to a Existing Layer (Agregar a una capa
existente)

Asegúrate de que la opción Vectorize Image (Vectorizar
imagen) NO esté marcada. Y selecciona la opción Keep As
Original Bitmap (Mantener como mapa de bits original).

IMPORTACIÓN DE...
imágenes



¿Haz hecho una marioneta en otro programa
como Photoshop y quieres armarlo en 

Toon Boom? 
En el menú superior, selecciona File >
Import > Images (Archivo > Importar >
Imágenes).
En la sección Files (Archivos) del cuadro de
diálogo Import Images (Importar imágenes),
haz clic en Browse (Examinar) para buscar
y seleccionar tu archivo de photoshop.
Selecciona la opción Crear capas basadas
en nombres de archivos. 
Al darle al botón de aceptar te saldrá una
2da ventana donde hay que especificar en
Crear: capas individuales.

¡Tu marioneta está lista en tu área de
trabajo y línea del tiempo para empezar a
darle un rig y trabajar con los nodos para

darle estructura y luego animarla!

IMPORTACIÓN DE...
marioneta



Toon Boom te permite importar audios o
sonidos para tus animaciones, ya sea para
tenerlos de referencia a la hora de animar o
para que vengan añadidos directamente en tus
renders. Para importar un archivo de audio
hay que seguir las siguientes indicaciones:

Archivo > Importar > Sonido... 
Selecciona el archivo de audio/sonido que
desees usar.
Toon Boom cargará el archivo y luego este
aparecerá en tu línea del tiempo. (Asegurate
de tener activado el botón de sonido para
que tu audio se reproduzca cada que des
play en la línea del tiempo).

¿Y cómo le hacemos para el apartado de Lip-
sync? ¡Checa el capítulo 14 del siguiente
manual!

IMPORTACIÓN DE...
sonido para lip-sync

https://docs.toonboom.com/download/harmony
/20.0/advanced/Harmony_20_Advanced_Getting

_Started_Guide_ES.pdf

https://docs.toonboom.com/download/harmony
/20.0/advanced/Harmony_20_Advanced_Getting

_Started_Guide_ES.pdf



Recuerda que en el lip-sync hay que tener
diferentes ilustraciones de bocas

parecidas a los fonemas de la siguiente
carta de fonemas estándar de la

industria de la animación.

La ilustración de la boca tiene que estar
aplicada antes de que suene el fonema
del audio que usemos. 

Si nuestro personaje tiene que decir
HOLA, antes de que suene la O, el
personaje tiene que tener la posición de
su boca para la O ya puesto, y antes de
que suene la L, tiene que tener la
posición su boca para la L, etc.

https://youtu.be/6l3mVMqYJ4g?
si=TTjF1imhyiAodj50

https://youtu.be/6l3mVMqYJ4g?
si=TTjF1imhyiAodj50

¡Checa el siguiente vídeo!¡Checa el siguiente vídeo!



Cuando hablamos de “empaquetado” en terminos de
Toon Boom nos referimos a tener nuestra marioneta

(con su rig, acomodo de nodos, etc.) hecho y pasarlo a la
librería de Toon Boom para que lo podamos utilizar en

otros proyectos.

 Selecciona el Peg Maestro de tu puppet. 
Arrastra la selección a tu vista de LIBRERÍA en el
apartado HARMONY PREMIUM LIBRERÍA.

Si aparece con un candado: clic derecho > Derecho
para modificar.

Como tu puppet ya se encuentra en una librería general
que se va a poder abrir en cualquier otro proyecto de
Toon Boom que abras en tu computadora, ¡podrás usarlo
cuando tu quieras!

Te recomendamos hacer antes un grupo y ahí tirar el
archivo de la librería que contiene el puppet.

EMPAQUETADO



¿QUÉ HAY QUE HACER SI HAY ELEMENTOS,
ILUSTRACIONES, ETC. QUE NO APARECIERON?

Tomemos por ejemplo el siguiente caso: Cuando se paso
está marioneta a un nuevo proyecto de Toon Boom este
aparecía sin el torso y antebrazos del puppet, a pesar de
que en el archivo original donde se hizo la marioneta SI
estaban.

Esto ha ocurrido debido a que algunos nodos/redes se
movieron de lugar una vez exportados al nuevo
proyecto.
¡Te recomendamos tener a un lado abierto el
archivo original donde se armo el puppet para que
puedas checar las diferencias y arreglarlo!

EMPAQUETADO

En la imagen 1 la ilustración de torso
NO está conectado al composite,

pero la imagen 2 SI lo está.

En la imagen 1 la ilustración de torso
NO está conectado al composite,

pero la imagen 2 SI lo está.

Imagen 1Imagen 1 Imagen 2Imagen 2



¿Qué es un Render? Es la agrupación de todos los
elementos del proyecto los cuales se procesan y
transforman. Por ejemplo: Se agrupan las
secuencias de frames para transformarlos en un
solo vídeo.

PASOS PARA SACAR UN RENDER EN TOON
BOOM: 

Archivo > Exportar > Película > H.264/MPEG-4
(*.mov) > Archivo de salida (donde se va a
guardar nuestro vídeo - de preferencia hay que
tener una carpeta exclusiva) + darle nombre al
render > Guardar > Aceptar.

PARA SACAR UN
RENDER



CTRL + S = Guardar
CTRL + N = Nuevo (proyecto nuevo)
CTRL + O = Abrir (abrir proyecto)
F5 = Extender exposición (fotogramas)
F6 = Insertar fotograma clave
F7 = Eliminar fotograma clave
Tecla ; = Ir al fotograma anterior
Tecla . = Ir al siguiente fotograma
CTRL + C = Copiar
CTRL + V = Pegar
CTRL + X = Cortar (copiar y pegar,
eliminando el elemento anterior).
CTRL + Z = Deshacer acción/cambios
CTRL + R o CTRL + Shift + R = Nuevo dibujo
vacío

SHORT-CUTSSHORT-CUTS
CTRL + A = Seleccionar todo
Tecla 1 = Zoom Out (alejar vista)
Tecla 2 = Zoom In (acercar vista)
F8 = Crear símbolo (Librería)
Tecla 4 = Voltear horizontal
Tecla 5 = Voltear vertical
SHIFT + T = Herramienta de transformación
A = Activar capa (línea del tiempo)
D = Desactivar capa (línea del tiempo)
SHIFT + J = Insertar fotograma vacío


